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The following experiments shall be conducted using MATLAB / Lab
View / CProgramming/ Equivalent software.( PART A)

1 Generation of sinusoidal waveform / signal based on recursive difference 1-5
equations

2 Find DFT / IDFT of given discrete time signal. 6-9

3 Find frequency response of a system given in transfer function/ differential 10-11
equation form.

4 Implementation of FFT of given Sequence. 12-15
Design and implementation of 1IR filter using bilinear transformation and 16-18
impulse invariantmethod.

6 Design and implementationof IIR Butterworth (LP/HP) filter. 19-20

7 Design and implementationof 1IR Chebyshev(LP/HP) filter. 21-22

8 Design and implementation of FIR with low pass filter using any three 23-26
windowingtechniques. Plot its magnitude and phase responses.

9 Design and implementation of FIR filter with high passfilter using any 27-30
three windowingtechniques. Plot its magnitude and phase responses.

10 Design and implementation of FIR filter with band pass / band stopfilter 31-38
using any three windowing techniques. Plot its magnitude and phase
responses.

The following experiments shall be conducted using (T1 / Analog
Devices / Motorola /Equivalent DSP processors). (PART - B)

1 Study the architecture of DSP chips — TMS 320C 5X/6X Instructions. 53-61
2 Find DFT / IDFT of given discrete time signal. 62-63
3 Implementation of FFT of given Sequence. 64-67
4 Design and implementation of IIR Butterworth / Chebyshev (LP/HP) filter. 68-70

Design and implementation of FIR with low pass / high pass filter using any 71-72

three windowingtechniques. Plot its magnitude and phase responses.
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ECE DEPT VISION & MISSION PEOs and PSOs

Vision: To produce highly skilled, creative and competitive Electronics and Communication Engineers
to meet the emerging needs of the society.

Mission:

> Impart core knowledge and necessary skills in Electronics and Communication Engineering
through innovative teaching and learning.

> Inculcate critical thinking, ethics, lifelong learning and creativity needed for industry and society

» Cultivate the students with all-round competencies, for career, higher education and self-
employability

I. PROGRAMME EDUCATIONAL OBJECTIVES (PEQOS)

PEOL1: Graduates apply their knowledge of mathematics and science to identify, analyze and
solve problems in the field of Electronics and develop sophisticated communication
systems.

PEQO2: Graduates embody a commitment to professional ethics, diversity and social awareness in

their professional career.

PEOS3: Graduates exhibit a desire for life-long learning through technical training and
professional activities.

Il. PROGRAM SPECIFIC OUTCOMES (PSOS)

PSOL: Apply the fundamental concepts of electronics and communication engineering to design
a variety of components and systems for applications including signal processing, image
processing, communication, networking, embedded systems, VLSI and control system

PSO2: Select and apply cutting-edge engineering hardware and software tools to solve complex
Electronics and Communication Engineering problems.

I11. PROGRAMME OUTCOMES (PO’S)
1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering fundamentals,

and an engineering specialization to the solution of complex engineering problems.

2. Problem analysis: Identify, formulate, review research literature, and analyze complex engineering
problems reaching substantiated conclusions using first principles of mathematics, natural sciences, and
engineering sciences.

3. Design/development of solutions: Design solutions for complex engineering problems and design
system components or processes that meet the specified needs with appropriate consideration for the
public health and safety, and the cultural, societal, and environmental considerations.

4. Conduct investigations of complex problems: Use research-based knowledge and research methods
including design of experiments, analysis and interpretation of data, and synthesis of the information to
provide valid conclusions.

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and modern
engineering and IT tools including prediction and modeling to complex engineering activities with an
understanding of the limitations.
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6. The engineer and society: Apply reasoning informed by the contextual knowledge to assess societal,
health, safety, legal and cultural issues and the consequent responsibilities relevant to the professional
engineering practice.

7. Environment and sustainability: Understand the impact of the professional engineering solutions in
societal and environmental contexts, and demonstrate the knowledge of, and need for sustainable
development.

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and norms of
the engineering practice.

9. Individual and team work: Function effectively as an individual, and as a member or leader in
diverse teams, and in multidisciplinary settings.

10. Communication: Communicate effectively on complex engineering activities with the engineering
community and with society at large, such as, being able to comprehend and write effective reports and
design documentation, make effective presentations, and give and receive clear instructions.

11. Project management and finance: Demonstrate knowledge and understanding of the engineering
and management principles and apply these to one’s own work, as a member and leader in a team, to
manage projects and in multidisciplinary environments.

12. Life-long learning: Recognize the need for, and have the preparation and ability to engage in
independent and life-long learning in the broadest context of technological change.

IV. COURSE OBJECTIVES

Students can learn the basics of using DSP chips to perform real-time digital signal processing.

Ability to apply knowledge of mathematics, science and engineering: Construction of tools for
visualizing the basic concepts of discrete signal representation such as Fourier transforms, discrete time
representations.

Students will learn numerous programming tools for design and implementations of filtering algorithms.

Understand the concept of Multi-rate signal processing and sample rate conversion.

Develop and Implement DSP algorithms in software using CCS with DSP floating pointProcessor.

V. COURSE OUTCOMES
After the completion of the course students will be able to

Course Course Outcome statements BTL

Outcomes

Co1 Ability to design-test, to verify, to evaluate, and to benchmark a real-time | L1
DSP system.

CO2 Ability to calculate discrete time domain and frequency domain of signals | L3
using discreteFourier series and Fourier transform.

CO3 Ability to design, using MATLAB-based filter design techniques, FIR | L4
and IIR digital filters and Determine the frequency response of filters.

CO4 Implementation of basic signal processing algorithms such as | L2
convolution, difference equation implementation and application of them
in the construction of FIR and IIR filters.

CO5 Design DSP based real time processing systems to meet desired needs of | L5
the society.
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VI.COURSE MAPPING WITH PO’S AND PEQ’S

T plP|P| PP plp PP
Title PO | P | PO | PO PO E|E
1002034201000 1yl 010

5067|809 1101299
DSPLab | 22 | 26| 22 |24 |26]| 22 | 14 2 20 | 22| 22| 26 |26 24

V_MAPPING OF COURSE OUTCOMES WITH PEO’S AND PO’S

Course

P | P

o PIPIPIPIPI PP IPIP P |P| 2] 7
0|o0jojolo|ofo|o0 i |00

112(3lal5| 6|7 |81 09 11 | 12 ? 2

Cco1 2 3 2 2 3 2 2 1 3 3 3 3 3 3

CcO2 1 2 3 2 2 2 1 2 1 2 3 2 2 3

({OX] 3 3 2 3 2 3 2 2 2 1 1 3 2 2

CO4 3 2 2 2 3 2 1 3 2 2 2 2 3 2

CO5 2 3 213 3 2 1 2 2 3 2 3 3 2

LABORATORY INSTRUCTIONS

1 While entering the Laboratory, the students should follow the dress code. (Wear shoes and
White apron, Female Students should tie their hair back).

2. The students should bring their observation book, record, calculator, necessary stationery items
and graph sheets if any for the lab classes without which the students will not be allowed for doing
the experiment.

3. All the Equipment and components should be handled with utmost care. Any breakage or
damage will be charged.

4. If any damage or breakage is noticed, it should be reported to the concerned in charge
immediately.

5 The theoretical calculations and the updated register values should be noted down in the
observation book and should be corrected by the lab in-charge on the same day of the laboratory
session.

6. Each experiment should be written in the record note book only after getting signature from the
lab in-charge in the observation notebook.

7. Record book must be submitted in the successive lab session after completion of experiment.

8. 100% attendance should be maintained for the laboratory classes.
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WORKING PROCEDURE WITH MATLAB:

1) Double click on Matlab icon. -> Then Matlab will be opened
2) To write the Matlab Program

Goto file menu-> New -> Script(Mfile) -> In the opened Script file write the Matlab code and save the
file with an extension of .m

Ex: “linear.m”

3)To execute Matlab Program Select the all lines in matlab program(ctrl+A) of mfile and press “F9”
to execute the matlab code

4)Entering the inputs in command window

[J If the command window is displaying the message like “enter the input sequence” then

enter the sequence with square brackets and each sample values is spaced with single space

Ex: Enter input sequence [1 2 3 4] Ifit is asking a value input write the value without brackets

Ex: “enter length of sequence 4” After entering inputs It displays the Output Graphs.
PROCEDURE TO WORK ON CODE COMPOSER STUDIO

Test the USB port by running DSK Port test from the start menu

Use Start[JPrograms[Texas Instruments1Code Composer StudioJCode Composer Studio
CDSKG6713 Tools] DSK6713 Diagnostic Utilities

[1 SelectJ Start[1Select DSK6713 Diagnostic Utility Icon from Desktop

(1 Select Start Option

[ Utility Program will test the board

(1 After testing Diagnostic Status you will get PASS

To create the New Project

Project [J New (File Name. pjt , Eg: Vectors.pjt)

To Create a Source file

File O New [ Type the code (Save & give file name, Eg: sum.c).

To Add Source files to Project

Project [J Add files to Project [1 c/ccs studio3.1/my projects/your project name/
sum.c(select the file type as c/c++ source files)

To Add rts.lib file & hello.cmd:

Project [J Add files to Project [Jrts6700.lib
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(Path:c/ccs studio3.1/cg tools/c6000/lib/ rts6700.lib)

Note: Select Object & Library in(*.0,*.1) in Type of files

Project [1 Add files to Project [Jhello.cmd

CMD file — Which is common for all non real time programs.

(Path: c/ccs studio3.1\tutorial\dsk 6713 \hello1\hello.cmd)

Note: Select Linker Command file(*.cmd) in Type of files

Compile:

To Compile: Project [1 Compile project

To Build: Project [ build project,

To Rebuild: Project [1 rebuild,

Which will create the final .out executable file.(Eg. Vectors.out).

Procedure to Load and Run program:

Load the program to DSK: File [J Load program [ Vectors. out

To Execute project: Debug [] Run.

1. Execution should halt at break point.

2. Now press F10. See the changes happening in the watch window.

3. Similarly go to view & select CPU registers to view the changes happening in CPU registers.
Configure the graphical window as shown below

INPUT

x[n] = {1, 2,3,4,0,0,00} h[kl={L 2340000}

CONNECTING DSP PROCESSOR TO PC

[1 Connect the dsp processor to the pc using usb cable connector.

[1 Check the DSK6713 diagnostics (IF you get the “pass”then click on ok).

(1 Click on ccs studio3.1 desk top icon. Then the window will be opened.

1 Go to debug click on connect (then target device will be connected to pc)

TO CREATE PROJECT

(1 Project new given project name and select the family’TMS320C67XX Then click ok

(1 File new source file write down the ‘c’program and save it with.’c’ extension in current project file
O File new dsp/bios.config file select dsk67xx click on dsk6713 and save it in current project.
) Project add files to project add source file

) Project add files to project add library file by following the given path
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[1 c/ccs studio3.1/cgtools/c6000/dsk6713/DSK6713.bs/file.

[1 Project add files to the project .Add the configuration file.

1 Now files are generated and included in generated files . in that open the 3rd file, and copy the
header file and paste it in source file. Copy the include files named as ”dsk6713.h” and

“dsk6713_aic23.h” paste it in current project folder.

1 Now compile project.(project compile)

[1 Project build. Project rebuild all.

[1 File load program project name.pjt debug “project name .out” file click on open debug click on run

1 Now apply the input sine wave to line in of dsk6713 Kit.

1 Observe the output at line out of dsk6713 by using CRO.

INTRODUCTION

MATLAB: MATLAB is a software package for high performance numerical computation and
visualization provides an interactive environment with hundreds of built in functions for technical

computation, graphics and animation . The MATLAB name stands for Matrix Laboratory.

MATLAB Windows : MATLAB works with through three basic windows

Command Window : This is the main window .it is characterized by MATLAB command prompt >>
when you launch the application program MATLAB puts you in this window all commands including
those for user-written programs ,are typed in this window at the MATLAB prompt

Graphics window: the output of all graphics commands typed in the command window are flushed to
the graphics or figure window, a separate gray window with white background color the user can create
as many windows as the system memory will allow

Edit window: This is where you write edit, create and save your own programs in files called M files.
Input-output:

MATLAB supports interactive computation taking the input from the screen and flushing, the output to
the screen. In addition it can read input files and write output files

Data Type: the fundamental data —type in MATLAB is the array. It encompasses several distinct data
objects- integers, real n umbers, matrices, charcter strings, structures and cells.There is no need to
declare variables as real or complex,

MATLAB automatically sets the variable to be real.

Dimensioning: Dimensioning is automatic in MATLAB. No dimension statements are required for
vectors or arrays .we can find the dimensions of an existing matrix or a vector with the size and length

commands.
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Where to work in MATLAB?

All programs and commands can be entered either in the a)Command window

b) As an M file using Matlab editor

Note: Save all M files in the folder 'work' in the current directory. Otherwise you have to locate the file
during compiling.

BASIC INSTRUCTIONS

T=0:1:10

This instruction indicates a vector T which as initial value 0 and final value 10 with an increment of 1 Therefore
T=[012345678910]

F=20:1:100 Therefore F =20 21222324 ......... 100]
T =0:1/pi: 1 Therefore T= [0, 0.3183, 0.6366, 0.9549]
zeros (1, 3)

The above instruction creates a vector of one row and three columns whose values are zero

Output=[00 0]

Syntax: w = conv(u,Vv)

Description: w = conv(u,v) convolves vectors u and v. Algebraically, convolution is the same operation
as multiplying the polynomials whose coefficients are the elements of u and v.

Disp Syntax: disp(X)

Description: disp(X) displays an array, without printing the array name. If X contains a text string, the
string is displayed.Another way to display an array on the screen is to type its name, but this prints a
leading "X=," which is not always desirable.Note that disp does not display empty arrays.

xlabel

Syntax: xlabel(*string")

Description: xlabel('string’) labels the x-axis of the current axes.

ylabel

Syntax : ylabel('string’)

Description: ylabel('string’) labels the y-axis of the current axes.

Title

Syntax : title("string")

Description: title('string’) outputs the string at the top and in the center of the current axes. .grid on
Syntax : grid on Description: grid on adds major grid lines to the current axes.

FFT

FFT(X) is the discrete Fourier transform (DFT) of vector X . For matrices, the FFT operation is applied
to each column. For N -D arrays, the FFT operation operates on the first non-singleton dimension.
FFT(X,N) is the N-point FFT, padded with zeros if X has less than N points and truncated if it has more.

DEPT. OF ECE SVR ENGINEERING COLLEGE 9
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Starting MATLAB:

After logging into your account, you can enter MATLAB by double-clicking on the MATLAB
shortcut icon (MATLAB 7.0.4) on your Windows desktop. When you start MATLAB, a special
window called the MATLAB desktop appears. The desktop is a window that contains other
windows. The major tools within or accessible from the desktop are:

The Command Window
The Command History
The Workspace

The Current Directory
The Help Browser

e The Start button

Menus change,

depending on the Use tab togo View or

tool you are to Workspace Get help.  changecurrent
currently using. browser. directary.

Move Command Window outside of
desktop (undock).

5]

=)k MATLAB

File Edit Debug Pesktop Mindow [Help

D@|%Eﬂﬁ|‘ﬁ|?||o-\mymfnes L'J
Shortouts [7] Howe to Adi [£] wihat's hews

[ e EETERE S f Command Window A X
ok & 5| B - =

< M AL TUL A E >
= Copyright 12984-2005 The MathliWork=s, Inc.
:I Wersion 7.0.4 (R143P2)

Al Files £ I File Type

bucky.m hi-file
ﬁ caution. mdl Model

Editor Aute|+
»
Currert Directory | Workspace |

Command History A ox

%—— 27237504 3:5% FH ——2ﬂ
ore on

collatzall. asy

To get started, sSelect MATLAE Help or Demos from th

g

format long =

cd d:/mymfiles/ses _te 1

clear

workspac il =
I | 3 Y >

4
E Y Startl \ L
| \E
Click Start View or exscute Drag the separator bar nter MATLAB functions at
button for quick previously run functions to resize windows. command-line prompt.
access to tools from the Command
and mara. History window.

Figure : The graphical interface to the MATLAB workspace
When MATLAB is started for the firsttime, the screen looks like the one that
shown in the Figure. This illustration also shows the default configuration of the
MATLAB desktop. You cancustomize the arrangement of tools and documents to suit
your needs.

Now, we are interested in doing some simple calculations. We will assume that you have
sufficient understanding of your computer under which MATLAB is being run. You are
now faced with the MATLAB desktop on your computer, which contains the prompt
(>>) in the Command Window.

Note: To simplify the notation, we will use this prompt, >>, as a standard prompt sign.
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Using MATLAB as a calculator

As an example of a simple interactive calculation, just type the expression you want to
evaluate. Let’s start at the very beginning. For example, let’s suppose you want to calculate the
expression, 1+ 2 x 3. You type it at the prompt command (>>) as follows,

>> 1+2*3

ans=7

You will have noticed that if you do not specify an output variable, MATLAB uses a default
variable ans, short for answer, to store the results of the current calculation. Note that the
variable ans is created (or overwritten, if it is already existed). To avoid this, you may assign a
value to a variable or outputargument name. For example

>>x = 1+2*3

X =7

Will result in x being given the value 1 + 2*3=7. This variable name can always

be used to refer to the results of the previous computations. Therefore, computing 4 result in
>> 4*X

ans =28.0000
3 Quitting MATLAB

To end your MATLAB session, type quit in the Command

Window, or select FileMATLAB in the desktop main menu.
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1. GENERATION OF SINUSOIDAL WAVEFORM /SIGNAL BASED ON
RECURSIVE DIFFERENCE EQUATIONS.
AIM: To generate sin signal and plot the same as a waveform showing all the specifications.

APPARATUS: PC with MATLAB Software.

PROCEDURE:

1. Click on the MATLAB Icon on the desktop.

2. MATLAB window open.

3. Click on the ‘FILE’ Menu on menu bar.

4. Click on NEW M-File from the file Menu.

5. An editor window open, start typing commands.

6. Now SAVE the file in directory.

7. Then Click on DEBUG from Menu bar and Click Run.

PROGRAM:

[e)

% Generation of signals and sequences
clc; clear all;

close all;

disp('SINE SIGNAL ");

N= input(' Enter Number of Samples : ");
n= 0:0.1:N;

x=sin(n) ;

subplot(2,1,1);

plot(n,x);

xlabel('Time"') ;

ylabel(' Am plitude');
title('Continuous sine Signal');
subplot(2,1,2);

stem(n,x);

xlabel('Time") ;

ylabel(' Am plitude');

title('Discrete sine Signal');
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Yo=-===nmmmmmmmnneee Generation of signals-------- %
yb=sawtooth (2*pi*50*t, .5);
figure;

subplot(2,2,1);

plot (t,y5);

axis ([0 0.1 -2 21);

xlabel ('time');

ylabel ("amplitude');

title (' triangular wave signal');
%generation of triangular wave sequence
subplot(2,2,2);

stem(t, y5);

axis ([0 0.1 -2 21);

xlabel('n'");

ylabel ("amplitude');
title('triangular wave sequence');
%generation of sinsoidal wave signal
y6=sin (2*pi*40*t);

subplot(2,2,3);

plot (t,y6);

axis ([0 0.1 -2 21);

xlabel ('"time') ;

ylabel ("amplitude');

title(' sinsoidal wave signal');
sgeneration of sin wave sequence
subplot(2,2,4);

stem(t, y6);

axis ([0 0.1 -2 21);

xlabel ('n'");

ylabel ("amplitude');

title('sin wave sequence');

DEPT. OF ECE SVR ENGINEERING COLLEGE




DSP LAB

11 B.TECH Il SEM

$To find the impulse response of the following difference equation
% y(n)-y(n-1)+0.9y(n-2)= x(n)

clc; clear all; close all;
disp('Difference Equation of a digital system');
N=input('Desired Impulse response length = ');

b=input('Coefficients of x[n] terms

")
")

a=input('Coefficients of y[n] terms
h=impz(b,a,N);

disp('Impulse response of the system is h = ');
disp(h);

n=0:1:N-1;

stem(n,h); xlabel('time index"'); ylabel('h[n]');

title( 'Impulse response')
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OUTPUT :

SINE SIGNAL

Enter Number of Samples : 16

Continuous sine Sig

nal
T

0.5

Am plitude
o

4 6

8

Time

10

Discrete sine Signa

Am plitude

amplitude

amplitude

-1

-2

k3

-

=

-1

-2

triangular wave signal

0.05
time
sinsoidal wave signal

0.05
time

amplitude

amplitude

16

triangular wave seguence

L
4T LYY

I

n
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Difference Equation of a digital system
Desired Impulse response length = 100
Coefficients of x[n] terms = 1
Coefficients of y[n] terms = [1-1 0.9]

Impulse response

h[n]
_O

%ﬁﬁﬁ%&&@mm

R Eisaans

RESULT: Various signals & sequences generated using Matlab software.

L L . . L . . L
20 30 40 50 60 70 80 90
time index

100
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2) TO FIND DFT / IDFT OF GIVEN DT SIGNAL

AIM: To find the DFT / IDFT of given signal.

APPARATUS: PC with MATLAB Software.
PROCEDURE:

1 Click on the MATLAB Icon on the desktop.

2 MATLAB window open.

3 Click on the ‘FILE’ Menu on menu bar.

4 Click on NEW M-File from the file Menu.

5 An editor window open, start typing commands.

6 Now SAVE the file in directory.

7 Then Click on DEBUG from Menu bar and Click Run.

1) PROGRAM:WITH BUILTIN FUNCTION.

cle;

x1 = input('Enter the sequence:’);
n = input('Enter the length:’);

m = fft(x1,n);

disp('N-point DFT of a given sequence:’);
disp(m);

N =0:1:n-1; subplot(1,2,1);
stem(N,m);

xlabel('Length’);
ylabel("Magnitude of X(k)");
title("Magnitude spectrum:');

an = angle(m);

subplot(1,2,2);

stem(N, an);

xlabel('Length’);

ylabel('Phase of X(k)");
title('Phase spectrum:’);

2) PROGRAM :WITHOUT BUILTIN FUNCTION.

N

input('Enter the the value of N(Value of N in N-Point DFT)');

X = input('Enter the sequence for which DFT is to be calculated');

n=[0:1:N-1];

k=[0:1:N-1];

WN=exp(-1j*2*pi/N); % twiddle factor
nk=n"*k;

WNnk=WN. *nk;

X1

AVA | g | NN P
AR=A"IWINTTR
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disp(Xk);

MagX=abs(Xk) % Magnitude of calculated DFT
PhaseX=angle(Xk)*180/pi % Phase of the calculated DFT
figure(1);

subplot(2,1,1);

title('MAGNITUDE PLOT ');

plot(k,MagX);

subplot(2,1,2);

plot(k,PhaseX)

title('PHASE PLOT ')

DEPT. OF ECE SVR ENGINEERING COLLEGE
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OUTPUT-1 :-

Enter the sequence:[1 1 0 0]

Enter the length:4

N-point DFT of a given sequence:
Columns 1 through 3

2.0000 1.0000 - 1.0000i 0
Column 4

1.0000 + 1.0000i

A Figure Mo. 1 E@@

File Edit Wiew Insert Tools ‘window Help

DeEdS X A A, 220

Magnitude spectrum: Fhase spectrum:

2 1
. P
=,
—= 1.5 = 0.5 1
= >
W = L, =
E 1 o @ ]
= (1]
E o0s T 05

o = -1

] 1 2 3 ] 1 2 3
Length Length

RESULT:- Thus Discrete Fourier Transform is Performed using Matlab.
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OUTPUT -2:

Enter the the value of N(Value of N in N-Point DFT)4
Enter the sequence for which DFT is to be calculated[1 1 0 0]

2.0000 + 0.0000i 1.0000 - 1.0000i 0.0000 - 0.0000i 1.0000 + 1.0000i
MagX =

2.0000 1.4142 0.0000 1.4142

PhaseX =

0 -45.0000 -90.0000 45.0000

2 T T T T T
15F 4
1 — -
0.5 7

O 1 1 1 1
0 0.5 1 1.5 2 25 3

PHASE PLOT

50 T T T T T
0 -
-50 [ 7

_100 1 1 1 1 1
0 0.5 1 1.5 2 25 3

RESULT: The DFT of given sequence is obtained . Hence the theory and practical value are proved.
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3 FREQUENCY RESPONSE OF A GIVEN SYSTEM GIVEN IN(TRANSFER

FUNCTION/ DIFFERENCE EQUATION FORM)
AIM :- To find the frequency response of the following difference equation

y(n) — 5y(n-1) = x(n) + 4 x(n-1)
APPARATUS: PC with MATLAB Software.

PROCEDURE:
1 Click on the MATLAB Icon on the desktop.

2 MATLAB window open.

3 Click on the ‘FILE’ Menu on menu bar.

4 Click on NEW M-File from the file Menu.

5 An editor window open, start typing commands.

6 Now SAVE the file in directory.

7 Then Click on DEBUG from Menu bar and Click Run.

Program:-

b

[1, 4]; %Numerator coefficients

[1, -5]; %Denominator coefficients

a

W = -2*pi: pi/256: 2*pi;

[h] = freqz(b, a, w);

subplot(2, 1, 1), plot(w, abs(h));
xlabel('Frequency \omega');
ylabel('Magnitude');

grid

subplot(2, 1, 2);

plot(w, angle(h));
xlabel('Frequency \omega');

ylabel('Phase - Radians');

grid
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OUTPUT:-

J  Figure No. 1 g@@|

File Edit Mew Insert Tools “Window Help

DedES " AAsr B2L0

1.4 T

hagnitude

o ! :
E 2---------5—--------5- --------------------------------------------------- —
= ' 1
= ‘ ‘
e R S H e e e  RREEEEE -
i : ‘
Liy] ' 1
% R NS YRR AT PSR P -
J_FL-'-'—*__.L-___\ f-—"‘_“_hh-___\
4 | | | | | | |
g -B 4 2 0 2 4 a g

Freguency

RESULT:- Thus the MATLAB program for Frequency Response of Difference Equation was
performed and the output was verified.

Note:- If the transfer function is given instead of difference equation then perform the inverse Z-

Transform and obtain the difference equation and then find the frequency response for the
difference equation using Matlab.
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4) IMPLEMENTATION OF FFT OF GIVEN SEQUENCE

AIM: To performthe FFT of signal x(n) using Mat lab.
APPARATUS: PC with MATLAB Software.

PROCEDURE:
1 Click on the MATLAB Icon on the desktop.

2 MATLAB window open.

3 Click on the ‘FILE’ Menu on menu bar.

4 Click on NEW M-File from the file Menu.

5 An editor window open, start typing commands.
6 Now SAVE the file in directory.

7 Then Click on DEBUG from Menu bar and Click Run.

THEORY :- A fast Fourier transform (FFT) is an efficient algorithm to compute the discrete Fourier
transform (DFT) and its inverse. FFTs are of great importance to a wide variety of applications, from
digital signal processing and solving partial differential equations to algorithms for quick

multiplication of large integers.

2 POINT
a5t Fourier Transform
4 FOIRIT
/ A POINT
g FOIMT
/ 2 POINT

4 FOIRIT \

2 POIRIT

ALGORITHM:

1) Get the input sequence

2) Number of DFT point(m) is8

3) Find out the FFT function using MATLAB function.

4) Display the input & outputs sequence using stem function
5)Compile and Run the program

6)For the output see command window\ Figure window
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1) PROGRAM:

clear all;

N=8;

m=8;

a=input('Enter the input sequence’);
n=0:1:N-1;

subplot(2,2,1);

stem(n,a);

xlabel('Time Index n’);
ylabel('Amplitude’);
title("Sequence”);

x=fft(a,m);

k=0:1:N-1;

subplot(2,2,2);
stem(k,abs(x));
ylabel('magnitude”);
xlabel('Frequency Index K');

title('Magnitude of the DFT sample’);

subplot(2,2,3);
stem(k,angle(x));
xlabel('Frequency Index K;
ylabel('Phase’);

title('Phase of DFT sample’);
ylabel('Convolution’);

OUTPUT:-

Enter the input sequence[11110000]
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J Figure No. 1 QEIFE

File Edit Yew Insert Tools Window Help
DEeEdE M AAs 220
SEQUEnCcE hagnitude of the DFT sample
Tip—p—p—p il
0.8 3
ok} [k}
= 0B E
= £2
£ 0.4 1 T
=L =
0.2 ] 1 T T
d G—o—G—& d & & =
1 2 4 5 8 1 2 4 5 8
) TR
2
c T
=
§ [ = &;. = {F =
G
iy - - -
1 2 4 B g
Fraguency Index k.

RESULT:- Thus Fast Fourier Transform is Performed using Matlab.

2) PROGRAM:

clc;

clear all;

close all;

x=input('Enter the sequence:');
n=input('Enter the length of fft: );
%compute fft

disp('Fourier transformed signal’);
X=fft(x,n);

subplot(1,2,1);

stem(x);

title('i/p signal’);
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xlabel('n --->);
ylabel('x(n) -->");grid;
subplot(1,2,2);stem(X);
title('FFT of i/p x(n) is:");
xlabel('Real axis --->");
ylabel('Imaginary axis -->');
grid;
OUTPUT :
Enter the sequence:[5 4 7 8]
Enter the length of fft: 8
Fourier transformed signal
ilp signal FFT of i/p x(n) is:
8 T T /-) 25 T T T
o}
7r o}
20 r
6 -
A 151
5¢ =
2
A 5
5 4 0] g 10
X =
&
3 -
E 4l
2 T D
0 S
d : :
O _5 1 1 1
1 2 3 4 0 2 4 6 8
n---> Real axis --->
RESULT :-- N point FFT algorithm using Matlab is designed.
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5) DESIGN AND IMPLEMENTATION OF IIR FILTER USING BILINEAR
TRANSFORMATION AND IMPULSE INVARIANTMETHOD.

AIM: To design and implementation of iir filter using bilinear transformation and impulse invariant
method using matlab.

APPARATUS: PC with MATLAB Software.

PROCEDURE:

1 Click on the MATLAB Icon on the desktop.
2 MATLAB window open.

3 Click on the ‘FILE’ Menu on menu bar.

4 Click on NEW M-File from the file Menu.

5 An editor window open, start typing commands.

6 Now SAVE the file in directory.

7 Then Click on DEBUG from Menu bar and Click Run
PROGRAM:

% Design using both bilinear and impulse invariant transformations an IR
% digital low-pass Butterworth filter having following specifications:

% 0.8 <|H(ejm)|< 1, |0|< 0.27
% |H(ejw)|< 0.2, 0.6n < |o|<m
% Assume T =1 sec.

% Without using ‘buttord’ inbuilt function.

clear all;

close all;

clc;

alphap = 20*logle(1) - 20*1ogle(@.8); %Calculating the passband attenuation
alphas = 20*1logle(1) - 20*1logle(@.2); %Calculating the stopband attenuation
op = 2* tan(@.1*pi) %analog passband frequency

os = 2* tan(@.3*pi) %analog stopband frequency
ki = abs (os/op);

Al = (10~(@.1*alphas) -1 )"0.5;

A2 = (1e~(@.1*alphap) -1 )"0.5;
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A = A1/A2;

N = ceil(A/k1l) % order of the transfer function

k3 = 1/(2*N);

k4 = (10~(@.1*alphap) - 1)” k3;

oc = op/k4 % cutoff frequecny calculation

[b,a] = butter(N,oc)

% b and a return the numerator and denominator of the transfer function
w = 0:.01:pi;

[h,om] = freqz (b,a,w, 'whole");

m = abs (h);

an = angle (h);

subplot (2,1,1)

plot (om/pi, m),

grid, ylabel ('Normalized Magnitude'),

xlabel ('Normalized Frequency');

subplot (2,1,2)

plot (om/pi, an),

grid, ylabel ('Angle'),

xlabel ('Normalized Frequency');

[bzl,az1l]=impinvar(b,a,1l) % impulse invariant transform of the function

[bz2,az2]=bilinear(b,a,1l) % Bilinear transform of the function

DEPT. OF ECE SVR ENGINEERING COLLEGE
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OUTPUT:

Normalized Magnitude
>
T

O | 1 | 1 1 | 1 1 1
0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1

Normalized Frequency

O T T T T T T T T

Angle

3r 1 1 L 1 1 L 1 I 1 J
0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1
Normalized Frequency

RESULT: IIR filter using bilinear transformation and impulse invariantmethod using
matlab is implemented.
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6) DESIGN AND IMPLEMENTATIONOF IIR BUTTERWORTH (LP/HP) FILTER.
AIM:To writa a matlab program for design and implementationof iir butterworth (Ip/hp) filter.

APPARATUS: PC with MATLAB Software.
PROCEDURE:

1 Click on the MATLAB Icon on the desktop.

2 MATLAB window open.

3 Click on the ‘FILE’ Menu on menu bar.

4 Click on NEW M-File from the file Menu.

5 An editor window open, start typing commands.

6 Now SAVE the file in directory.
7 Then Click on DEBUG from Menu bar and Click Run.

PROGRAM:

clc;

clear all;

close all;

disp(‘'Enter the Analog filter design specifications');
N=input('Enter the order of the filter");
c=input('Enter the choice of filter 1. LPF 2. HPF 3.BPF 4.BSF \n ;
if(c==1)

disp(‘Frequency response of Analog LPF is:";
Cf=100;

[b,a]=butter(N,Cf,'S);

freqs(b,a);

end

if(c==2)

disp(‘Frequency response of Analog HPF is:");
Cf=100;

[b,a]=butter(N,Cf,'HIGH",'S");

freqs(b,a);

end

if(c==3)
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disp(‘'Frequency response of Analog BPF is:');
Cf1=[10 100];

[b,a]=butter(N,Cf1,'S");

freqs(b,a);
end
if(c==4)

disp('Frequency response of Analog BPF is:");

Cf1=[10 100];

[b,a]=butter(N,Cf1,'STOP",'S";

freqs(b,a);

end

OUTPUT :

Enter the Analog filter design specifications

Enter the order of the filter6

Enter the choice of filter 1. LPF 2. HPF 3.BPF 4.BSF

2

Frequency response of Analog HPF is:

Magnitude

1072 1071 10° 10" 102 103
Frequency (rad/s)

Phase (degrees)
o

-100 -

-200
1072 107" 10° 10" 102 103

Frequency (rad/s)

RESULT :-- Analog filters using Matlab is designed.
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7) DESIGN AND IMPLEMENTATIONOF IIR CHEBYSHEV(LP/HP) FILTER.
AIM: To design and implementation of IR Chebyshev (LP/HP) filter.
APPARATUS: PC with MATLAB Software.

PROCEDURE:

1 Click on the MATLAB Icon on the desktop.

2 MATLAB window open.

3 Click on the ‘FILE’ Menu on menu bar.

4 Click on NEW M-File from the file Menu.

5 An editor window open, start typing commands.

6 Now SAVE the file in directory.

7 Then Click on DEBUG from Menu bar and Click Run.

PROGRAM :
% chebyshev low pass filter
clc;

clear all;

wp=0.5;

%% % chebyshev low pass filter;

ws=0.7;

rp=1;

rs=50;

[n,wn]=cheblord(wp,ws,rp,rs);
[b,a]=chebyl(n,rp,wn);
[h,w]=freqz(b,a,128);

subplot(1,2,1);

plot(abs(h)); xlabel(‘frequency’); ylabel('amplitude’);
title('low pass chebyshev filter response’);
%%% chebyshev high pass filter
wp=0.7;

ws=0.5;

rp=1;

rs=30;

[n,wn]=cheblord(wp,ws,rp,rs);

[b,a]=chebyl(n,rp,wn, 'high");
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[h,w]=fregz(b,a,128);
subplot(1,2,2);
plot(abs(h));
xlabel('frequency");
ylabel('amplitude’);

title("high pass chebyshev filter response’)

Output :

Io1w pass chebyshev filter response hi?h pass chebyshev filter response

VA R

0.8 1 0.8

0.7 . 0.7

o
(o]
T
1
o
(@]
T

amplitude
o o o
w BN &)}
T T T
1 1 1
amplitude
o o o
w B (&)}
T T T

o
N
T
1
o
N
T

011 1 011

O 1 1 O L
0 50 100 150 0 50 100 150
frequency frequency

RESULT : Design and implementationof iir chebyshev(lp/hp) filter using matlab is verified.

VIVA QUESTION:

What do you mean by cut-off frequency?

Give the difference between analog and digital filter?

What is the difference between type 1 and type 2 filter structure?
what is the role of delay element in filter design?

Explain how the frequency is filter in filters?

Differences between Butterworth chebyshev filters?

Can IR filters be Linear phase? how to make it linear Phase?

NookrwdE
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8) DESIGN AND IMPLEMENTATION OF FIR WITH LOW PASS FILTER
USING ANY THREE WINDOWINGTECHNIQUES. PLOT ITS MAGNITUDE
AND PHASE RESPONSES.

AIM :- To Design FIR LP Filter using Rectangular/Triangular/kaiser Windowing Technique.
APPARATUS: PC with MATLAB Software.

PROCEDURE:

1 Click on the MATLAB Icon on the desktop.
2 MATLAB window open.

3 Click on the ‘FILE’ Menu on menu bar.

4 Click on NEW M-File from the file Menu.

5 An editor window open, start typing commands.
6 Now SAVE the file in directory.

7 Then Click on DEBUG from Menu bar and Click Run.
ALGORITHM:-

1) Enter the pass band ripple (rp) and stop band ripple (rs).

2) Enter the pass band frequency (fp) and stop band frequency (fs).
3) Get the sampling frequency (f), beta value.

4) Calculate the analog pass band edge frequencies, wl and w2.

wl = 2*fp/f
w2 = 2*fs/f

5) calculate the numerator and denominator
6)Use an If condition and ask the user to choose either Rectangular Window or Triangular

window or Kaiser window..

7)use rectwin,triang,kaiser commands
8) Calculate the magnitude of the frequency response in decibels (dB

m=20*log10(abs(h))
9) Plot the magnitude response [magnitude in dB Vs normalized frequency (om/pi)]
10)Give relevant names to x and y axes and give an appropriate title for the plot.

11)Plot all the responses in a single figure window.[Make use ofsubplot]
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PROGRAM:-

%FIR Filter design window techniques
clc;
clear all;
close all;
rp=input(‘enter passband ripple’);
rs=input(‘enter the stopband ripple");
fp=input(‘enter passband freq’);
fs=input(‘enter stopband freq’);
f=input(‘enter sampling freq ');
beta=input('enter beta value,,);
wp=2*fp/f;
ws=2*fs/f;
num=-20*log10(sqrt(rp*rs))-13;
dem=14.6*(fs- fp)/f;
n=ceil(num/dem);
nl=n+1,
if(rem(n,2)~=0)
nl=n;
n=n-1;
end
c=input(‘enter your choice of window function 1. rectangular 2. triangular 3.kaiser: \n ");
if(c==1)

y=rectwin(nl);

disp('Rectangular window filter response’);
end
if (c==2)

y=triang(nl);

disp(‘Triangular window filter response’);
end
if(c==3)

y=kaiser(nl,beta);

disp(‘kaiser window filter response’);
end
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%LPF

b=firl(n,wp,y);

[h,0]=freqz(b,1,256);
m=20*log10(abs(h));

plot(o/pi,m);

title('LPF");

ylabel('Gain in dB-->");

xlabel('(a) Normalized frequency-->");

Output:-

enter passband ripple 0.02
enter the stopband ripple 0.01
enter passband freq 1000
enter stopband freq 1500
enter sampling freq 10000

enter beta value

enter your choice of window function 1. rectangular 2. triangular 3.kaiser:

1

Rectangular window filter response

J Figure Mo. 1

[

Gain in dB-»

File Edit Wiew Insert Tools WWindow Help

=EHE= e A A s B2 T

10

LPF

E9((=0[E9

o

-10

-20

-30

-40

-50

-E0

-0

-30

-an 1 1 1

1 1
o 0.1 0.2 0.3 0.4 0.5
(2) Maormalized frequency--=

o7
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enter your choice of window function 1. rectangular 2. triangular 3.kaiser:
2
triangular window filter response

A4 Figure NMo. 1

Eil= Edit i Inzerk Tonol=s witirnd o Help
LPF

=10 -

-15 |

-0

-

(5an in 48>

-30

-55

_ao |

A5 L L L L 1 L L L i
o (| o2 o.= L § 0. O o o.s o9 1

(a) Mormalized frequency--=

enter beta value 5

enter your choice of window function 1. rectangular 2. triangular 3.kaiser:
3

kaiser window filter response

(=)

A Figure Mo, 1
Ells Edic WS Inserkt Tools RO [T L= TEN] Help

O = ol & A A - | = = T
LPF
=0 .

]

-20

-A0

-E0

Ganin 8->

=u]

-100

=120

n n n n n n s n n
m} [ | o= 0.3 [ § o.s 0.5 0.7 o.s 0.9 1
(a) FMormalized frequency--=

RESULT:- Thus FIR LP Filter is designed for Rectangular/triangular/kaiser windowing
techniquesusing MATLAB.
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9) DESIGN AND IMPLEMENTATION OF FIR FILTER WITH HIGH PASSFILTER USING
ANY THREE WINDOWINGTECHNIQUES. PLOT ITS MAGNITUDE AND PHASE
RESPONSES.

AIM :- To Design FIR HP Filter using Rectangular/Triangular/kaiser Windowing Technique.
APPARATUS: PC with MATLAB Software.

PROCEDURE:

1 Click on the MATLAB Icon on the desktop.

2 MATLAB window open.

3 Click on the ‘FILE’ Menu on menu bar.

4 Click on NEW M-File from the file Menu.

5 An editor window open, start typing commands.

6 Now SAVE the file in directory.

7 Then Click on DEBUG from Menu bar and Click Run.

ALGORITHM:-

Enter the pass band ripple (rp) and stop band ripple (rs).

Enter the pass band frequency (fp) and stop band frequency (fs).
Get the sampling frequency (f), beta value.

Calculate the analog pass band edge frequencies, wl and w2.

— N N

1
2
3
4
wl = 2*fp/f

w2 = 2*fs/f

5) calculate the numerator and denominator

6) Use an If condition and ask the user to choose either Rectangular Window or Triangular
window or Kaiser window..

7)use rectwin,triang,kaiser commands

8) Calculate the magnitude of the frequency response in decibels (dB

m=20*log10(abs(h))

9) Plot the magnitude response [magnitude in dB Vs normalized frequency (om/pi)]
10) Give relevant names to x and y axes and give an appropriate title for the plot.

11)Plot all the responses in a single figure window.[Make use of subplot]
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PROGRAM:-

%FIR Filter design window techniques
cle;
clear all;
close all;
rp=input(‘enter passband ripple’);
rs=input(‘enter the stopband ripple’);
fp=input(‘enter passband freq’);
fs=input('enter stopband freq’);
f=input(‘enter sampling freq ");
beta=input(‘enter beta value’);
wp=2*fp/f;
ws=2*fs/f;
num=-20*log10(sqrt(rp*rs))-13;
dem=14.6*(fs- fp)/f;
n=ceil(num/dem);
nl=n+1;
if(rem(n,2)~=0)
nl=n;
n=n-1;
end
c=input(‘enter your choice of window function 1. rectangular 2. triangular 3.kaiser: \n ");
if(c==1)

y=rectwin(nl);

disp('Rectangular window filter response’);
end
if (c==2)

y=triang(nl);

disp(‘Triangular window filter response”);
end
if(c==3)

y=kaiser(nl,beta);

disp(‘kaiser window filter response’);
end
%HPF
b=firl(n,wp, high"y);
[h,0]=freqz(b,1,256);
m=20*log10(abs(h));
plot(o/pi,m);
title("HPF");
ylabel('Gain in dB-->");
xlabel('(b) Normalized frequency-->');
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OUTPUT:-

enter passband ripple 0.02
enter the stopband ripple 0.01
enter passband freq 1000
enter stopband freq 1500
enter sampling freq 10000

enter beta value

enter your choice of window function 1. rectangular 2. triangular 3.kaiser:

1

Rectangular window filter response

A Figure Mo._ 1

File Edit e In=ert Tools LT e P=TEN] Help

O H S &k A A -~ &= i

1

a

-10

-20

-=20

Bain in dB--=

-40

-0

-0

a oo [ = o3

by Mormalized frequency--=

enter your choice of window function 1. rectangular 2. triangular 3.kaiser:

2
triangular window filter response
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A Figure Mo. 1
Fil= Edit %iew Inserk Tools WWindowe He=lp

HFF
o '

=10

=15

(5ain in dB--=

-20

-25

_BD 1 1 1 1 1 1 1 1 1
a a1 o.2 ] o4 0.5 (W =] a.F o.S o3 1

[h) rRlarmalized frequency->

enter beta value 5

enter your choice of window function 1. rectangular 2. triangular 3.kaiser:
3

kaiser window filter response

A Figure Mo. 1

Fil= Edit Wiew Insert Tools ‘Window Help
DS 8 A A 72 &2 0
HFF
1 T

a

Gain in dB--
b
]

1 1 1 1 1 1 1
o 0.1 0.2 o3 o4 0.5 0.6 o.7 0.5 0.9 1
(b) Marmalized frequency--=

RESULT:- Thus FIR HP Filter is designed for Rectangular/triangular/kaiser windowing
techniquesusing MATLAB.
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10 ) DESIGN AND IMPLEMENTATION OF FIR FILTER WITH BAND PASS /
BAND STOPFILTER USING ANY THREEWINDOWING TECHNIQUES. PLOT

ITS MAGNITUDE AND PHASE RESPONSES.

AIM : To design and implementation of fir filter with band pass / band stopfilter using any three
windowing techniques. plot its magnitude and phase responses using matlab.

APPARATUS: PC with MATLAB Software.

PROCEDURE:

1 Click on the MATLAB Icon on the desktop.

2 MATLAB window open.

3 Click on the ‘FILE’ Menu on menu bar.

4 Click on NEW M-File from the file Menu.

5 An editor window open, start typing commands.

6 Now SAVE the file in directory.

7 Then Click on DEBUG from Menu bar and Click Run.

PROGRAM :

MATLAB CODE FOR KAISER WINDOW:
clc;

clear all;

close all;

passripple=0.04; %pass band ripple
stopripple=0.05; %stop band ripple
passfreq=2000; %pass band ripple
stopfreq=3000; %pass band ripple
freq=9000; %sampling freq
wp=2*passfreg/freq;
ws=2*stopfreq/freq;
s=passripple*stopripple;
r=stopfreg-passfreq;

p=r/freq;

N=-20*log10(sqrt(s))-13;
D=14.6*p;

n=ceil(N/D);
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nl=n+1;

if(rem(n,2)~=0)

nl=n;

n=n-1;

end

beta=2;

for beta=2:2:4

y=kaiser(nl,beta);

b=firl(n,wp, low"y); %low pass filter
[h,0]=freqz(b,1,256);
m=20*log10(abs(h));

figure(beta)

subplot(2,2,1);

plot(o/pi,m,'b");

title('Low pass filter");

ylabel(‘gain in db");

xlabel('(a) normalised frequency’);
b=firl(n,wp, 'high'y); %high pass filter
[h,0]=freqz(b,1,256);
m=20*log10(abs(h));
subplot(2,2,2);

plot(o/pi,m,'b");

title(‘high pass filter");

ylabel( 'gain in db’);

xlabel('(b) normalised frequency');
wn=[wp,ws]; %band pass filter
b=firl(n,wn,y);
[h,0]=freqz(b,1,256);
m=20*log10(abs(h));
subplot(2,2,3);
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plot(o/pi,m,’d";

title('Band pass filter’);
ylabel('gain in db’);
xlabel('(c)normalised frequency’);
b=firl(n,wn,'stop',y); %band stop filter
[h,0]=freqz(b,1,256);
m=20*log10(abs(h));
subplot(2,2,4);

plot(o/pi,m,'b");

title("band stop filter');

ylabel('gain in db’);

xlabel('(d) normalised frequency’);

end
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OUTPUT : FIGURE 1: When beta value is 2.
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MATLAB CODE FOR COMPARISION OF WINDOW METHODS
clc;

clear all;

close all;

passripple=0.04; %pass band ripple
stopripple=0.05; %stop band ripple
passfreq=2000; %pass band ripple
stopfreq=3000; %pass band ripple
freq=9000; %sampling freq
wp=2*passfreq/freq;
ws=2*stopfreq/freq;
s=passripple*stopripple;
r=stopfreq-passfreq;

p=r/freq;
num=-20*log10(sqrt(s))-13;
dem=14.6*p;

n=ceil(num/dem);

nl=n+1;

if(rem(n,2)~=0)

nl=n;

n=n-1,

end

beta=4;

y=kaiser(nl,beta);
b=firl(n,wp,'low"y); %low pass filter
[h,0]=freqz(b,1,256);
m=20*log10(abs(h));

figure(2)

subplot(2,2,1);

plot(o/pi,m,'d");

title('L ow pass filter');
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ylabel('gain in db’);

xlabel('(a) normalised frequency’);
b=firl(n,wp, high',y); %nhigh pass filter
[h,0]=freqz(b,1,256);
m=20*log10(abs(h));

subplot(2,2,2);

plot(o/pi,m,'b");

title('high pass filter");

ylabel( 'gain in db’);

xlabel('(b) normalised frequency’);
wn=[wp,ws]; %band pass filter
b=firl(n,wn,y);

[h,0]=freqz(b,1,256);
m=20*log10(abs(h));

subplot(2,2,3);

plot(o/pi,m,'b");

title('Band pass filter");

ylabel(‘gain in db");
xlabel('(c)normalised frequency;
b=firl(n,wn,'stop',y); %band stop filter
[h,0]=freqz(b,1,256);
m=20*log10(abs(h));

subplot(2,2,4);

plot(o/pi,m,'b");

title('band stop filter');

ylabel('gain in db";

xlabel('(d) normalised frequency');
hold on

ys=rectwin(nl);

b=firl(n,wp,'low',ys); %low pass filter

[h,0]=freqz(b,1,256);
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m=20*log10(abs(h));

figure(1)

subplot(2,2,1);

plot(o/pi,m,'r');

title("Low pass filter’);

ylabel(‘gain in db’);

xlabel('(a) normalised frequency’);
b=firl(n,wp,'high'ys); %high pass filter
[h,0]=freqz(b,1,256);
m=20*log10(abs(h));
subplot(2,2,2);

plot(o/pi,m,'r');

title("high pass filter’);

ylabel( 'gain in db'’);

xlabel('(b) normalised frequency’);
wn=[wp,ws]; %band pass filter
b=firl(n,wn,ys);
[h,0]=freqz(b,1,256);
m=20*log10(abs(h));
subplot(2,2,3);

plot(o/pi,m,'r");

title('Band pass filter’);
ylabel(‘gain in db’);
xlabel('(c)normalised frequency;
b=firl(n,wn,'stop',ys); %band stop filter
[h,0]=freqz(b,1,256);
m=20*log10(abs(h));
subplot(2,2,4);

plot(o/pi,m,'r");

title('band stop filter');

ylabel('gain in db"); xlabel('(d) normalised frequency");
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OUTPUT :
Blue color- Kaiser Window, Red color-Rectangular window

Low pass filter high pass filter

gainin db
& & A N
o o o o
gain in db
d A N
o o o (@]

0] 0.5
(a) normalised frequency
Band pass filter

-
o

0.5 1
(b) normalised frequency
band stop filter

gainindb
® A N
o o o
gainindb

A N o

-
O

(¢} 0.5

0.5 1
(c)normalised frequency

(d) normalised frequency

Low pass filter high pass filter

gainin db
&
o o
gainin db
A N
o o o

-100 -60
0 0.5 1 0 0.5 1
(a) normalised frequency (b) normalised frequency
0 Band pass filter band stop filter
0
S 20 | B8 -5t
= £
= £ 10}
S-40} {1 S
15t
-60 . -20 *
0 0.5 1 0 0.5 1
(c)normalised frequency (d) normalised frequency

DEPT. OF ECE SVR ENGINEERING COLLEGE 38




DSP LAB

111 B.TECH Il SEM

ADDITIONAL PROGRAM

11) DESIGN OF IIR FILTER USING ANYOF THE AVAILABLE METHODS
AND VERIFY THE FREQUENCY RESPONSE OF THE FILTER

AIM: To write a matlab program for design of IIR filter using anyof the available methods

and verify the frequency response of the filter.
APPARATUS: PC with MATLAB Software.
PROCEDURE:

1 Click on the MATLAB Icon on the desktop.

2 MATLAB window open.

3 Click on the ‘FILE’ Menu on menu bar.

4 Click on NEW M-File from the file Menu.

5 An editor window open, start typing commands.

6 Now SAVE the file in directory.

7 Then Click on DEBUG from Menu bar and Click Run.
PROGRAM:
% IIR FILTERS LPF & HPF USING MATLAB
clc;
clear all;
close all;
disp(‘enter the IIR filter design specifications’);
rp=input(‘enter the passband ripple’);
rs=input(‘enter the stopband ripple’);
wp=input(‘enter the passhand freq’);
ws=input(‘enter the stopband freq’);
fs=input(‘enter the sampling freq";
wl=2*wp/fs;w2=2*ws/fs;
[n,wn]=buttord(wl,w2,rp,rs,'s";
% IIR FILTERS LPF & HPF USING MATLAB
clc;
clear all;

close all;

disp(‘enter the IR filter design specifications’);
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rp=input(‘enter the passband ripple’);
rs=input(‘enter the stopband ripple’);
wp=input(‘enter the passband freq’);
ws=input('enter the stopband freq’);
fs=input('enter the sampling freq");
wl1=2*wp/fs;w2=2*ws/fs;
[n,wn]=buttord(wl,w2,rp,rs,'s");
c=input('enter choice of filter 1. LPF 2. HPF \n");
if(c==1)

disp(‘Frequency response of IIR LPF is:");
[b,a]=butter(n,wn,’'low’,'s");

end

if(c==2)

disp(‘Frequency response of IIR HPF is:");
[b,a]=butter(n,wn, 'high’,'s";

end

w=0:.01:pi;

[h,om]=freqs(b,a,w);
m=20*log10(abs(h));

an=angle(h);
figure,subplot(2,1,1);plot(om/pi,m);
title('magnitude response of IR filter is:");
xlabel('(a) Normalized freq. -->");
ylabel('Gain in dB-->");
subplot(2,1,2);plot(om/pi,an);

title('phase response of IR filter is:");
xlabel('(b) Normalized freq. -->";

ylabel('Phase in radians-->";
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OUTPUT :--
enter the IIR filter design specifications
enter the passband ripple.5
enter the stopband ripple.8
enter the passband freqgl000
enter the stopband freg2000
enter the sampling freg3000
enter choice of filter 1. LPF 2. HPF
1
Frequency response of IIR LPF is:
magnitude response of IR filter is:
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(b) Normalized freq. -->
RESULT :-- IIR filters using matlab is designed.
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VIVA QUESTION:

What is filter?
What is FIR and IIR filter define, and distinguish between these two?
What is window method? How you will design an FIR filter using window method?
What are low-pass and band-pass filter and what is the difference between these two?
What is the matlab command for Hamming window? Explain.
What do you mean by built in function ‘abs’ and where it is used?
Explain how the FIR filter are stable?
Why is the impulse response "finite"?
What does "FIR" mean?
. What are the advantages of FIR Filters (compared to IIR filters)?
. What are the disadvantages of FIR Filters (compared to IIR filters)?
. What terms are used in describing FIR filters?
. What is the delay of a linear-phase FIR?
. What is the Z transform of a FIR filter?
. What is the frequency response formula for a FIR filter?
. How Can I calculate the frequency response of a FIR using the Discrete Fourier
Transform (DFT)?
. What is the DC gain of a FIR filter?
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CC STUDIO PROGRAMS
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INTRODUCTION TO DSP PROCESSORS

A digital signal processor (DSP) is an integrated circuit designed for high- speed data
manipulations, and is used in audio, communications, image manipulation, and other data-acquisition
and data-control applications. The microprocessors used in personal computers are optimized for tasks
involving data movement and inequality testing. The typical applications requiring such capabilities are
word processing, database management, spread sheets, etc. When it comes to mathematical
computations the traditional microprocessor are deficient particularly where real-time performance is
required. Digital signal processors are microprocessors optimized for basic mathematical calculations

such as additions and multiplications.

Fixed versus Floating Point:

Digital Signal Processing can be divided into two categories, fixed po int and

floating point which refer to the format used to store and manipulate numbers within the devices.
Fixed point DSPs usually represent each number with a minimum of 16 bits, although a different
length can be used. There are four common ways that these 216 i,e., 65,536 possible bit patterns
can represent a number. In unsigned integer, the stored number can take on any integer value
from 0 to 65,535, signed integer uses two's complement to include negative numbers from -
32,768 to 32,767. With unsigned fraction notation, the 65,536 levels are spread uniformly
between 0 and 1 and the signed fraction format allows negative numbers, equally spaced
between -1 and 1.
The floating point DSPs typically use a minimum of 32 bits to store each value. This results in
many more bit patterns than for fixed point, 232 i,e., 4,294,967,296 to be exact. All floating point
DSPs can also handle fixed point numbers, a necessity to implement counters, loops, and signals
coming from the ADC and going to the DAC. However, this doesn't mean that fixed point math
will be carried out as quickly as the floating point operations; it depends on the internal
architecture.

C versus Assembly:

DSPs are programmed in the same languages as other scientific and engineering applications,
usually assembly or C. Programs written in assembly can execute faster, while programs written

in C are easier to develop and maintain. In traditional applications, such as programs run on PCs
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and mainframes, C is almost always the first choice. If assembly is used at all, it is restricted to
short subroutines that must run with the utmost speed.

How fast are DSPs?

The primary reason for using a DSP instead of a traditional microprocessor is speed: the ability
to move samples into the device and carry out the needed mathematical operations, and output
the processed data. The usual way of specifying the fastness of a DSP is: fixed point systems are
often quoted in MIPS (million integer operations per second). Likewise, floating point devices
can be specified in MFLOPS (million floating point operations per second).

TMS320 Family:

The Texas Instruments TMS320 family of DSP devices covers a wide range, from a 16-bit fixed-
point device to a single-chip parallel-processor device. In the past, DSPs were used only in
specialized applications. Now they are in many mass- market consumer products that are
continuously entering new market segments. The Texas Instruments TMS320 family of DSP
devices and their typical applications are mentioned below.

C1x, C2x, C2xx, C5x, and C54x: The width of the data bus on these devices is 16 bits. All have
modified Harvard architectures. They have been used in toys, hard disk drives, modems, cellular
phones, and active car suspensions.

C3x: The width of the data bus in the C3x series is 32 bits. Because of the reasonable cost and
floating-point performance, these are suitable for many applications. These include almost any
filters, analyzers, hi- fi systems, voice- mail, imaging, bar-code readers, motor control, 3D
graphics, or scientific processing.

C4x: This range is designed for parallel processing. The C4x devices have a 32-bit data bus and
are floating-point. They have an optimized on-chip communication channel, which enables a
number of them to be put together to form a parallel-processing cluster. The C4x range devices
have been used in virtual reality, image recognition, telecom routing, and parallel-processing
systems.

C6x: The C6x devices feature VelociTl ™, an advanced very long instruction word (VLIW)
architecture developed by Texas Instruments. Eight functional units, including two multipliers and
six arithmetic logic units (ALUS), provide 1600 MIPS of cost-effective performance. The C6x
DSPs are optimized for multi-channel, multi function applications, including wireless base
stations, pooled modems, remote-access servers, digital subscriber loop systems, cable modems,

and multi-channel telephone systems.
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Typical Applications for the TMS320 Family

The TMS320 DSPs offer adaptable approaches to traditional signal-processing problems and
support complex applications that often require multiple operations to be performed

simultaneously.

Automotive ‘Consumer ‘Control

Adaptive nide  control Digital radios/ TVs Dhsk drive control
Cellular telephones ‘Music synthesizers 'Laser printer control
Dhgital radios Pagers Ivlotor control
MNavigation Fadar detectors Servo control
Vibration analysis Solid-state answering machines
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General-Purpose Graphics/Tmaging Industrial

Adaptive filtermg 3-D transformations Numeric control
Convolution Ammation/digital maps Power-line monitormg
Correlation Homomorphic processing Eobotics

Digital filtering Image compression transmission Security access

Fast Fourier transforms Image enhancement

Instrumentation Medical MAilitary

Dugital filtering Dhiagnostic equapment Image processing
Function generation Fetal momtoring Miissile gudance
Pattern matching Heanng aids Navigation

Phase-locked loops

Patient monitoring

Radar processing

Selsmic processing Prosthetics Radio frequency modems
Spectrum analysis Ulira sound equipment Secure communications
Transient analvsis Sonar processing GPS
Telecommunications Voice/Speech

1200- to 56 600-bps modems Faxing Speaker verification

Adaptive equalizers

Future terminals

Speech enhancement

ADPCM transcoders
Echo cancellation

Line repeaters
.25 packet switching

Speech recognition
Speech synthesis

Channel multiplexing FDA Speech coding
Data encryption Speaker phones Text-to-speech
Dhgital PBXs Spread spectrum Voice mail
Dhgital speech  interpelation
DTMF encoding/decoding Video conferencing
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INTRODUCTION TO TMS 320 C6713 DSK

The high—performance board features the TMS320C6713 floating-point DSP. Capable of
performing 1350 million floating point operations per second, the C6713 DSK the most powerful
DSK development board.

CE7132 DSK Board

+ SN Universal
Power Supply

I AC Power Cord I

CE713 DSK Code
Composer Studio CD

TMS320CE6713 DSK
Technical Reference

The DSK is USB port interfaced platform that allows to efficiently develop and test
applications for the C6713. With extensive host PC and target DSP software support, the DSK
provides ease-of- use and capabilities that are attractive to DSP engineers.

The 6713 DSP Starter K it (DSK) is a low-cost platform which lets customers evaluate and
develop applications for the Texas Instruments C67X DSP family.
The primary features of the DSK are:

» 225 MHz TMS320C6713 Floating Point DSP

» AIC23 Stereo Codec

» Four Position User DIP Switch and Four User LEDs
» On-board Flash and SDRAM

TI*s Code Composer Studio development tools are bundled with the 6713DSK providing the
user with an industrial-strength integrated development environment for C and assembly
programming.

Code Composer Studio communicates with the DSP using an on-board JTAG emulator through a
USB interface.

The TMS320C6713 DSP is the heart of the system. It is a core member of Texas Instruments"
C64X line of fixed point DSPs whose distinguishing features are an extremely high performance
225MHz VLIW DSP core and 256Kbytes of internal memory. On-chip peripherals include a 32-
bit external memory interface (EMIF) with integrated SDRAM controller, 2 multi-channel
buffered serial ports (McBSPs), two on-board timers and an enhanced DMA controller (EDMA).
The 6713 represents the high end of TI"s C6700 floating point DSP line both in terms of
computational performance and on-chip resources.

The 6713 has a significant amount of internal memory so many applications will have all code
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and data on-chip. External accesses are done through the EMIF which can connect to both
synchronous and asynchronous memories. The EMIF signals are also brought out to standard Tl
expansion bus connectors so additional functionality can be added on daughter card modules.

DSPs are frequently used in audio processing applications so the DSK includes an on-board
codec called the AIC23. Codec stands for coder/decoder,the job of the AIC23 is to code analog
input samples into a digital format for the DSP to process, then decode data coming out of the
DSP to generate the processed analog output. Digital data is sent to and from the codec on

McBSP1.
IMS32 713 DSK Overview Block Diagram

Memory Exp

-{MIETH
-1 LNEIN |
-{ LIME OUT ]
-[HFouT

McBSPs | |

ARLAE
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SDRAM
Host Port Int

Voltage
Reg i
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Line In Headphone
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Power USB DIP LEDs Reset Config External Hurricane
Jack Port Switches Switch Switch JTAG Header

The DSK has 4 light emitting diodes (LEDs) and 4 DIP switches that allow users to interact with
programs through simple LED displays and user input on the switches. Many of the included
examples make use of these user interfaces Options.

The DSK implements the logic necessary to tie board components together in a
programmable logic device called a CPLD. In addition to random glue logic, the CPLD
implements a set of 4 software programmable registers that can be used to access the on-board
LEDs and DIP switches as well as control the daughter card interface.
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DSK hardware installation

Shut down and power off thePC

Connect the supplied USB port cable to theboard

Connect the other end of the cable to the USB port of PC

Plug the other end of the power cable into a poweroutlet

Plug the power cable into the board

The user LEDs should flash several times to indicate board is operational
When you connect your DSK through USB for the first time on a
Windows loaded PC the new hardware found wizard will come up. So,
Install the drivers(The CCS CD contains the require drivers for C6713
DSK).

» Install the CCS software for C6713 DSK.

YVVVVYVYYYV

Troubleshooting DSK Connectivity

If Code Composer Studio IDE fails to configure your port correctly, perform the following steps:

s Test the USB port by running DSK Port test from the start menu

Use Start—-> Programs—> Texas Instruments - Code Composer Studio> Code Composer Studio
C6713 DSK Tools »C6713 DSK Diagnostic Utilities

o The below Screen will appear
o Select 6713 DSK Diagnostic Utility Icon from Desktop
e The Screen Look like as below

Select Start Option

Utility Program will test the board
o After testing Diagnostic Status you will get PASS
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[Sb]6713DSK Diagnostics

General l Advanced |

Overall Diagnostic Test: - Diagnostic Status: M

USE Dizaghostics

% , ETSRaT

@ En'n.ula'hon Diagnostics DSK: S

@ DSP Diagnostics z .—]

s E | b Component l Wolue: l

A EASIALEESION Utility Aevizion 1.12 Bsset Emul

@ Flash Dinghostics =

@ Codec Diaghnostice Reset DSK I

@ LED Diagnostics

& Dhp St Diagnostics M
Help I

Diagriostic Fesults

If the board still fails to detect Go to CM OS setup Enable the USB Port Option
(The required Device drivers will load along with CCS Installation)

SOFTWARE INSTALLATION

You must install the hardware before you install the software on your system.

The requirements for the operating platform are;
¢ Insert the installation CD into the CD-ROM drive
An install screen appears; if not, goes to the windows Explorer
and run setup.exe
o Choose the option to install Code Composer Studio
If you already have C6000 CC Studio IDE installed on your PC,do not install DSK
software. CC Studio IDE full tools supports the DSK platform

Respond to the dialog boxes as the installation program runs
The Installation program automatically configures CC Studio IDE for operation with your DSK
and creates a CCStudio IDE DSK icon on your desktop. To install, follow these instructions:
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1) STUDY THE ARCHITECTURE OF DSP CHIPS - TMS 320C 5X/6X
INSTRUCTIONS.

INTRODUCTION

The TMS320C6713 (C6713) is based on the VLIW architecture, which is very well suited for numerically
intensive algorithms. The internal program memory is structured so that a total of eight instructions can be
fetched every cycle. For example, with a clock rate of 225MHz, the C6713 is capable of fetching eight 32-

bit instructions every 1/(225 MHz) or 4.44 ns. Features of the C6713 include 264 kB of internal memory
(8kB as L1P and L1D Cache and 256kB as L2 memory shared between program and data space), eight
functional or execution units composed of six arithmetic-logic units (ALUS) and two multiplier units, a 32-
bit address bus to address 4 GB (gigabytes), and two sets of 32-bit general-purpose registers.

The C67xx (such as the C6701, C6711, and C6713) belong to the family of the C6x floating-point processors,
whereas the C62xx and C64xx belong to the family of the C6x fixed-point processors. The C6713 is capable
of both fixed- and floating point processing.

An application-specific integrated circuit (ASIC) has a DSP core with customized circuitry for a specific
application. A C6x processor can be used as a standard general-purpose DSp programmed for a specific

application. Specific purpose digital signal processors are the modem, echo canceler, and others. A

fixed-point processor is better for devices that use batteries, such as cellular phones, since it uses less power
than does an equivalent floating-point processor. The fixed-point processors, C1x, C2x, and C5x, are 16-bit
processors with limited dynamic range and precision. The C6x fixed-point processor is a 32- bit processor
with improved dynamic range and precision. In a fixed-point processor, it is necessary to scale the data.
Overflow, which occurs when an operation such as the addition of two numbers produces a result with more

bits than can fit within a processor’s register, becomes a concern.

A floating-point processor is generally more expensive since it has more “real estate” or is a larger chip
because of additional circuitry necessary to handle integer as well as floating-point arithmetic. Several

factors, such as cost, power consumption, and speed, come into play when choosing a specific DSp.

The C6x processors are particularly useful for applications requiring intensive computations. Family
members of the C6x include both fixed-point (e.g., C62x, C64x) and floating-point (e.g., C67X) processors.

Other DSp’s are also available from companies such as Motorola and Analog Devices.
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Figure : Functional block diagram of TMS320C6713

The TMS320C6713 onboard the DSK is a floating-point processor based on the VLIW architecture [6-10].
Internal memory includes a two-level cache architecture with 4 kB of level 1 program cache (L1P), 4 kB of

level 1 data cache (L1D), and 256 kB of level 2 memory shared between program and data space.

It has a glue less (direct) interface to both synchronous memories (SDRAM and SBSRAM) and
asynchronous memories (SRAM and EPROM). Synchronous memory requires clocking but provides a
compromise between static SRAM and dynamic DRAM, with SRAM being faster but more expensive than
DRAM. On-chip peripherals include two McBSPs, two timers, a host port interface (HPI), and a 32-bit EMIF.
It requires 3.3 V for 1/0 and 1.26 V for the core (internal). Internal buses include a 32-bit program address
bus, a 256-bit program data bus to accommodate eight 32-bit instructions, two 32-bit data address buses, two
64- bit data buses, and two 64-bit store data buses.With a 32-bit address bus, the total memory space is 232 =
4GB, including four external memory spaces: CEO, CE1, CE2, and CE3. Figure shows a functional block
diagram of the C6713 processor included with CCS.
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TMS320C6X- PROCEDURE FOR USING C60 DEBUGGER

Stepl: Open > 6177 Diagnostic > start > Stop > Close

671 3DSK Diagnostics

General I Advanced |

— Dwerall Diagnoshic Test

1S5B Diagnostics

DSP Diaghostics
Extermal b emory
Flazh Diagrnoztics
Codec Diagnostics
LED Diagnostcs
Dip Swt Diaghostics

T

Ernulation Diagnoshics

Diagnostic Skatus ﬂl
(Y Stop |
Comporert I Walue I
LIkiliky R esvizion 112 Fe
Board Werzion 2 Stop the C
CPLD “WYersion 2 Fesct DSE |

Save s

Help

Diagnostic Fezults

Starting diagnoztic tezt suite,

-+ Aunmmg USE diagnostics.

--» Running emulator diaghostics

- Running DSF diagnosztics.
-+ Running extermnal memory diagnostics,

Step 2: Project > New > Project Name > Target > TMS320C67XX

File

Edit Wiew Project Debug GEL Option Profle Tooks DSPEIOS  Window

Help

‘]‘%

ETE I

B YL

WEE s EE |4 %A A6

| Hleaas 082 % | 64]

B oDuEHEE

™
»
iR
®

[=

&

EEEERLY

Files
[+ GEL Files
[ Projects

Project Creation

Project Mame: |sinewsve

Laocatior:

[ \Dosumerts and Settingsddmnstia |

Project Tupe: | Executable [ outl

Targat

TMS 3200670

ThS3Z0CE2
TH

Cancel | Help
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Step 3: Libraries > Add Files to Project > My Project > C600 > CG Tools »>

Library > rts6700.lib

# JC6713 DSKSCPU_1 - C621x - Code Composer Studio - Mot Connected

Fie Edit Wiew Project Debug GEL Option Profile Tools DSPJBIOS ‘indow Help
D % BB H LH&' o ' Ta G 25 | S N2 ‘ GE S uﬁ%ﬁ§§\§3§\/‘%%%|.’|
[mevwerve pit ~I[oetua Sl e@Ems 0 8|[>% | 85|
Bleo | oEmEEHEL
B Files
> (22 GEL Files
(=423 Projects

b =& sinewave.pjt (Debu
™ (L1 pependent Project
- (£ Documents
¥ |l DSP{BIOS Config
e (L) senerated Files
! (3 Include
“ (A Libraries

. [l source
2
ﬁ_ Add Files to Project
= —
I Loak.in: | 3 lib =« ok E-
[ Fastmathe?s [ rsa4nn [ rtse7one
|= fastmathe?xe  [Ertse400_eh  [El)rtss7o0e_eh
7= = rtss200 = resed00e

[ rsez00_eh

&1 = rtsaz00e =

rts6200e_ch

File name: [ns6700

Files of type: |Dbiect and Library Files (%0717

Step 4: File > New > Source File > Write Program in window

# /C6713 DSK/CPU_1 - C621x - Code Composer, Studio - Hot Connected

File Edit Wiew Project Debug GEL Option  Profie Tools DSP/BIOS ‘window Help

EEETEEY T BRI LA e S e
Isinewavepil ;"Dehug ;”@Iﬁll El] ‘H‘S‘% | .&|
Ble | oDmEEHEL

| [T Fies 1 Untitled1 *
™ [#-[Z1 GEL Files

=459 Projects #1include<stdio . h> =

#1nclude<math .h>

= ﬁ sinewave.pjt {Debu float a[i00]:

?} [ Dependent Project N

o (23 Documents main(])

o [0 DSPJBIOS Config int i:
|| S Forci Lo oo

t @ 0 tbraries a[i]=sin(2*3.14%5%xi,100);

[ Source

& printf("x=f ~n".,a[i]):

- }

&

=2
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Step 5: File > Save as > CStudio > my project > sss.c

£ fC6713 DSK/CPU_1 - C621x - Code Composer Studio - Mot Connected

File Edit ‘iew Projectk Debug GEL  Option Profile Tools DSPBIOS  window Help
BEE| BB e S E R R RY SR s kAT CE AL
Isinewavepit L”Dehug L” & | CUNE | 5\ % | . )f/-l |

Bl 0EBEHEL

™ Q Files 63
| | BT SR Files

Ela Projects
{rp Elﬁ sinewave.pijt {Debu
_{'} [ Dependent Project
(i
0 (23 Include
1 (23 Libraries
&
b
=
=
&1

«

Untitled1 *

#includedstdia . h>

#include<math -h>
float a[100]:
main( )

i

int 1i:
for(i=0;i<100;i++)

{
ali]=sin(Z*3.14=5=i100)
printf ("%f ~n",a[i1]):

+
1

Save in: IE J zinaa

| & @& cF E-

File name: |s|nawave,c]

Save I

Save as bype: IE/C++ Source files [*.c¥]

Cancel |
Help |
|

=]

Step 6: Source > Add Files to project > CStudio > lib > confi.c

4 JC6F13 DSKACPU_1 - C621x - Code Composer Studio - Hot Connected

File Edit View Project Debug GEL  Option Profile  Teols DSP/BIDS  ‘Window Help
B s @2l o FlEa sk oW [ EalssEE+% %8|
[Sinewarve pit ~|[Debug =] & &4 2% | W R B R | [ |
Bl oaEmEEHEL
® Files 1. sinawave.c
s g SEL fies #include<stdio.h> =
. i Fyoiests N #include<math .h>
1 = g5 sinewave.pjt (Debu Float a[100]:
™ Dependent Project main () -
= -2 bocuments
o -[Z2 DSPIBIOS Config int i:
= [L Generated Files AP -
3 3 Telude for(1—0,1<100,1++)
& g e a[i]=sin(2*3. 14%S%i/100)
& E Configurationl ]._;rlntf( #E matealil):
; ¥ fdd Files to Project
Look in: | I3 b =] = =5 B2
nfigurat
=
&7
File name: |Configuration? cig_c Open |
Files of type: IC Source Files [*.c." coc) LI Canasl I
Help |
1
4 I 3
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Step 7: Source > Add Files to Project > CStudio > C600 -> Tutorial >

link cmd = hello.cmd

Dsk6713 - hellol >

# JC6713 DSK/CPU_1 - C621x - Code Composer Studio - Mot Connected

File Edit “iew Project Debug GEL  Option  Profile  Tools DSPIEIOS  ‘Window  Help
B & BR[| S| e Fa 2 [ S0 | e Wik [ EE| 4 R 6|
Isinewave.pil ;”Debug ;” @ - | ‘l@ ﬁ | S‘ ?‘ | . & |

Flow D EmEEHEL

™ 1. sinawave.c = |
il #includedstdia. h>
el Ela Pro]e_cts ) #include<math h> =
{F Elﬁ sinewavwe.pjt {Debu A
N float =a[100]:
™ -[Z7) Dependent Project main()
= D Documents
L5 [0 DSPYBIOS Config int i:
— L0 Generated Files s -
0 3 Tnelude for(l—D,l(lDD,1++)
fis ! (3 Libraries ali]=sin(Z=35.14%5=i 1007 ;
: 3 Source printf ("xf “n'".,a[i]):
& [#] Configurationt i - -
3 hello, crnd =

g ¥ Add Files to Project

Laok. in: I 1= hellol ;I - £ ER-
IC)Debug
[hello.cs_
@ CUnFiguratiUnlch

hE:"lj

File name: Ihello Open I

Filez of type: ILinker Command File [*.cmd:” cf] ;I Cancel |

Help |
|
< vl

Step 8: Project > Compile File

# /C6713 DSK/CPU_1 - C671x - Code Composer Studio

File Edit View Project Debug GEL Option Profils Tools DSR(BIOS Window Help
BEE| b @] o S E R R T B[ e [EE| 4% A

|sineveave.pit

_~|[pebua

Lﬂ@lﬁlﬂﬂ_‘.\@vﬂlﬁi%|.&|

Ble | o BEEREEA

™ P Files 1 sinawave.c Z
o g pGEL mfs #include<stdia . h> —
i il . #include<math.h> —
£F =l &g sinewave.pijt (Debu Float a[100];
™ [ Dependent Project z -
(2 Documents main ()
=
¥ L3 0SPIBIOS Config int
<] B Gereratedries PR it Disassembly
& 423 Libraries (il 00004E24 DFFFBE112 |
- [ rsev00lib all O0004E25 O1AT102A
& =23 Source prin 00004E2C 01800064
= [#] Configuration1 ¥ 2hoon4E30 0oon4non
. hello. cmd i D0D04E34 00000000 o
= 00004E38 00000000
| 00004E3C 00000000
0D0D04E40 00000012
00004E44 00006000
annnarFas Nnnnnni? L]
= =0 3.
| | P
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Step 9: Project > Build all

! 5o T Gl ) L
| open...
sinewave pit Use External Makefile... N ) B ™ [ &
————— Export to Makefie...
B 6 @  AddFilestoProject...
 save
™ | [FFes | close
o ‘ : gs Source Control >
y S & CompleFile
®

Build Clean (1=0:;i<100;i++)

“ = Configurations...
Build Options...
File Specific Options...

2
S Functi
=

J=sin(2%3.14=5=i/100);
ptf("%f \n",a[i]):

Project Dependencies...
Show Project Dependencies
| Show File Dependencies

| Scan All File Dependencies
| Recent Project Files

~| [[GEL StartUp Complete.
Use -heap option to change the default si

Build Complete.,
0 Errors. 2 Warnings. 0 Remarks. _I

Step 10: File > Load Program - Debug > Output File

# fC6F13 DSK/CPU_1 - C671x - Code Composer Stu
File Edit Wiew Project Debug GEL Option  Profile  Tosls DSPJBIOS  Window Help

B E| % e o | EEEEE I

+

Fa| EE| 4% R | e |

»
[Sinewave pit ~I[Bebug SN
Ble oEmEEHEL

i Files
™ (L EL Files
= A Projects

sinawave.c

#include<stdia._-h>
#include<math . h>

¥
&

i = &5 sinewave.pit (Debu Fimor oTihoe
™ L3 Dependent Project oot
i L3 Documents ma{

.3 bR/BIOS Confia fat

1z
'3 Senerated Files For(i—0:;i<i00:i++)
{

{3 3 meclude

41 “Z3] Libraries <

“ - a[i]=-sin(2%3. 14%5%i 100]) ;

b rts6700.1ib " o "

& iy printf ("ZEF ~n".alil):

= g sinawave.c :

oo hello.cmd + Load Program
i Look i [ £ Debug

=)

&1

File: name: [simeware Open |
Files of wpe: [ ~out - Cancel
Help

GEL sStartUp Complete.
Use -heap option to change the default si

Euild Complete.
0 Errers, 2 Warnings, 0 Remarks. j
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Step 11: Debug > Run

File Edit ¥iew Project GEL Option  Profile  Tools DSP/BIOS  window  Help
wr b | % Bz g Breskeoints.. ﬁﬁ"’éﬁ%%’fﬂék‘?‘ﬂg*?é u?%ﬁEE\EE|/‘%ﬁ%|.“
Probe Paints...
| sinewave. pit Step Into F11 h 9| =
Step Ower Fi0
| e %ﬂ Step Out Shift-+F11
® Fies
= 51 GEL Files Halk Shift-+FS
(5 =1 projects Animate AlE+FS
¥ = @ sinewa  RunFree CEr+FS
™ CJDep  Runto Cursor Ctrl+F10
[ Doc  SetPCta Cursor Cerl+Shift+F10
" ~[Z2D3F  Multipls Operation...
= 8 IG:E’“ Assembly/Source Stepping ]
& (=423 Liby Reset CPU Cerl+R i 100) ;
. Restart Chrl+Shift+FS [i7): -
& = S|3Eu o Main =
ﬁ_ hellyl  Reset Emulator Chrl+Shift+R.
= Disconnect AlkC
e Restore Debug Stats
=
= Enable Thread Level Debugging. ..
Real-time Mode
@ Enable Rude Real-time Mode
&1 + Flush Fipeline on Halt
< | =
0~
—0.599886 =| |[*EL StartUp Complete.
-0.955670
-0.818001
—-0.600340
-0.323974

Step 12: Veiw > Graph > Time/Frequency

File Edit  Wiew Project GEL  Option  Profile  Tools DSPIBIOS  Window  Help
| ¥ G Sl EEEERIELA ES|+% %A |
Probe Paints...
[simewmarve pit step Into 11 mog | P S &
Step Ower Fio
& =
@ | =] Step Out Shift+F11
W [T
ﬁ‘ G GEL Files Halt: Shift+F5
B a Projects Anirmate Alt+Fs
fin E|§ sinewa RunFree Chrl+FS
?} Fun to Cursor Chrl+F10
Set PC to Cursor Chrl+5hift+F10
(g Hultiple Operation. ..
- Assembly/Source Stepping [
(¢) Reset CPU Chrl+R Cadi 100 ) .
‘2: Restar:t Crrl+Shift+FS [ i ] ) B
Go Main Chrl+M
2: Reset Emulator Chrl+Shift+R
E Disconnect AlL+C
S l
— Restore Debug State
[=]
= Enable Thread Level Debugging. ..
Real-time Mode
= Enable Rude Resl-time Made
&1 w Flush Pipeline on Halt
< s =
O[]
-0.999686 ~| |[2EL StartUp Complete.
-0.955670
-0.818001
-0.600340
-0.323974
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Step 13: Start Address ‘@’ and DSP data type- 32 bit floating point

File Edit “i=w Project Debug GEL Optisn Profile Tools DSP/BIOS “window Help

B4R E| o Sl 7 % e 05 & 02 | e [wi [ E | % A% o |
[snewae pit =][oebug Bl D \ ® & |
B & | B = s
™ Files . sinawave.c
(N =Tl #include<stdia-h>
T 1= . #include<math .h>
¥ =g sinewave.pjt (Debu float a[100];:
™ Dependent Project main () -
= (£ Documents
& (£ DSPIBIOS Config int i:
= £~ (B8 Corerated Flos £or(1-033<100:1+4+) & Graph Praperty
A =43 Libraries e . Display Tupe Single Time
£ C T ts6700lib al1 ]til’ﬂéi*i' Laxoxis100) 5 Graph Title Graphical Display
& =459 Seurce printf ("zf ~nt.oali]): Stant Address a
= T [A sinawave.c Acquisition Buffer Size 128
8 hello..cmd i Indes: Increment 1
= Display Data Size 200
- DSP Data Type 32-tit floating paint
Sampling Aate (Hz] 1
Plot Dista From Left to Right
Left-shift=d D ata Display es
Autoscale On
DC Yalue o
#ues Display on
— Time Display Unit s
Status Bar Display
Data Plet Style
Grid Stule Zero Line
Curser Made Dista Cursar
Cancel | Help
= i | =
).
0.322466 ~| |[(EL StartUp Complets.
0.014333
-0.295201
-0.57586%9
-0.800222 e
-0.946324 =
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2) FIND DFT / IDFT OF GIVEN DISCRETE TIME SIGNAL.

PROGRAM :
#include<stdio.h>
#include<math.h>
int N, k,n,i;
float pi=3.1416, sumre=0, sumim=0,out real[8]={0.0}, out imag([8]={0.0};
int x[32];
volid main (void)
{
printf (" enter the length of the sequence\n");
scanf ("%d", &N) ;
printf (" enter the sequence\n");
for (i=0;1i<N;i++)
scanf ("%d", &x[1]);
for (k=0; k<N; k++)
{
sumre=0;

sumim=0;

for (n=0;n<N; n++)

{

sumre=sumre+x[n]* cos (2*pi*k*n/N) ;

sumim=sumim-x[n]* sin(2*pi*k*n/N) ;

}

out real [k]=sumre;

out imag[k]=sumim;

printf ("X ([%d])=\t$f\t+\t%fi\n", k,out reallk],out imag([k]);

}

Dept. of ECE SVR ENGINEERING COLLEGE 62



RESULT :

INPUT ;

B Console X

zine [Project Debug Session] Texas Instruments ¥0S100w1 USE Emu
enter the length of the =sedquence
ta

|~

enter the sequence
112 -2 30651

"

OUTPUT :

El consale 2 [T Memoary Map
CEFHBLCOK, coxml: CIO

1

kziro])= 9.000000 + 0.0000001
Ti[1])= -1.292866 + 1.5555571
T([2])= 1.99994% + —5.0000291
T([3])= -2.706979 + 5.5355951
¥([4])= 3.000000 + 0.0000061
X([5])= -2.70751z + ~5.5354311
T([6])= 2.000164 + 4,99991%7 1
X([7])= -1.293085 + ~1.5353761
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3) IMPLEMENTATION OF FFT OF GIVEN SEQUENCE

PROGRAM :
//fft.c
#include <math.h>
#define PTS 64 //# of points for FFT
#define PI 3.14159265358979
typedef struct {float real,imag;} COMPLEX;
void FFT (COMPLEX *Y, int n); //FFT prototype
float iobuffer[PTS]; //as input and output buffer
float x1[PTS]; //intermediate buffer
short 1i; //general purpose index variable
short buffercount = 0; //number of new samples in iobuffer
short flag = 0; //set to 1 by ISR when iobuffer full
COMPLEX w[PTS]; //twiddle constants stored in w
COMPLEX samples[PTS]; //primary working buffer
main ()
{
for (i = 0 ; i<PTS ; i++) // set up twiddle constants in w
{
wl[i].real = cos(2*PI*i/(PTS*2.0)); //Re component of twiddle constants
wl[i].imag =-sin(2*PI*i/ (PTS*2.0)); //Im component of twiddle constants
}
for (1 = 0 ; 1 < PTS ; i++) //swap buffers
{
iobuffer[i] = sin(2*PI*10*1/64.0);/*10- > freq, 64 -> sampling freqg*/
samples[i] .real=0.0;
samples[i] .imag=0.0;

}
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for (i = 0 ; 1

{

< PTS ; 1i++) //swap buffers

samples[i] .real=iobuffer[i]; //buffer with new data

}

for (i = 0 ; 1

< PTS ; 1i++)

samples[i] .imag = 0.0; //imag components = 0

FFT (samples, PT

for (i =0 ; 1

S); //call function FFT.c

< PTS ; i++) //compute magnitude

x1[1] = sqrt(samples[i].real*samples[i].real+ samples[i].imag*samples[i].imaqg);

} //end of main

void FFT (COMPLEX *Y, int N) //input sample array, # of points

{

COMPLEX templ, temp2; //temporary storage variables

int i,j,k; //loop counter variables

int upper leg,
int leg diff;

int num stages

lower leg; //index of upper/lower butterfly leg
//difference between upper/lower leg

= 0; //number of FFT stages (iterations)

int index, step; //index/step through twiddle constant

i =1; //log(base2) of N points= # of stages

num stages +=1
i = 1*2;

}while (i!=N);
leg diff = N/2
step = (PTS*2)

for (i = 0;1i <

14

; //difference between upper&lower legs
/N; //step between values in twiddle.h

num stages; i++) //for N-point FFT
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{

index = 0;
for (3 = 0;
{

for (upper

{

lower leg =
templ.real
templ. imag

temp?2.real

temp2.imag

j < leg diff; j++)

leg = J;
upper legt+leg diff;

(Y[upper leg]).real

(Y[upper leg]).imag

(Y[upper leg]).real

(Y[upper leg]).imag

upper leg < N;

(2*leg diff))

upper leg +=

(Y[lower leg]) .real;
(Y[lower leg]) .imag;
(Y[lower leg]) .real;
(Y[lower leg]) .imag;

(Y[lower leg]) .real

temp2.real* (w[lindex]) .real

-temp2.imag* (w[index]) .imag;
(Y[lower leg]).imag = temp2.real* (w[index]) .imag
+temp2.imag* (w[index]) .real;

(Y[upper leg]) .real templ.real;

(Y [upper leg]) .imag templ.imag;
}

index += step;

}

leg diff = leg diff/2;

step *= 2;

}

j = 0;

for (1 = 1; i < (N-1); i++) //bit reversal for resequencing data
{

k = N/2;

while (k <= j)
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k = k/2;

}

J =3+ Kk
if (1<)

{

templ.real = (Y[]J]) .real;

templ.imag = (Y[]]) .imag;

(Y[J]) .real (Y[1]) .real;

(Y[31) .imag (Y[1]) .imag;

(Y[1]) .real templ.real;

(Y[1i]) .imag = templ.imag;

return;
}
RESULT :

INPUT

B Console X

=ine [Project Debug Session] Texas Instruments XDS100v1 IISE Emu
enter the length of the sequence

[
enter the secquence

112 -23 0651 w

OUTPUT :

El consale &3 | T Memary Map
CE748LC0K, coxml: CIO
1

f2([01)= =.000000 + 0.0000004
E([1])= -1.z92866 + 1.53555741
E([2])= 1.99994% + -5.0000291
E([3])= -2.706979 + 5.5355051
£([4])= 3.000000 + 0.0000064
E([5])= -z.70731z2 + -5.5354311
E{[6])= 2.000164 + 4.9999121
E([7])= -1.293085 + -1.5353761
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4) DESIGN AND IMPLEMENTATIONOF IR BUTTERWORTH / CHEBYSHEV
(LP/HP) FILTER.

PROGRAM :

// L138 iir intr.c

// IIR filter implemented using second order sections
// integer coefficients read from file

#include "L138 LCDK aic3106 init.h"

// bsl1800int.cof

#define NUM SECTIONS 3

int b[NUM SECTIONS][3] = {
{11538, -4052, 11538},
{32768, 599, 32768},

{32768, -22852, 32768} };

int a[NUM SECTIONS][3] = {
{32768, -5832, 450},
{32768, 17837, 26830},

{32768, -35076, 27634} };

int w[NUM SECTIONS] [2] {0};

interrupt void interrupt4 () //interrupt service routine
{
int section; // index for section number
int input; // input to each section
int wn,yn; // intermediate and output values in each stage

input = input left sample();
// input = (int)prbs();

for (section=0 ; section< NUM SECTIONS ; section++)
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wn = input - ((a[section][l]*w[section] [0])>>15) -
((a[section] [2]*w[section] [1])>>15);

yn = ((b[section] [0]*wn)>>15) + ((b[section][l]*w[section] [0])>>15) +
((b[section] [2]*w[section] [1])>>15);

w[section] [1] w[section] [0];

w[section] [0] = wn;

input = yn; // output of current section will be input to
}
output left sample((intl6é t) (yn)); // before writing to codec
return; //return from ISR

int main (void)

{

next

1138 initialise intr(FS_8000 HZ,ADC_GAIN O0DB,DAC ATTEN ODB,LCDK LINE_ INPUT);

while (1) ;

} // end of main()

Dept. of ECE SVR ENGINEERING COLLEGE

69



RESULT :

Magnitude response in the passhand

—— Chebyshey Type-1 (Ripple: 3dEB)
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5) DESIGN AND IMPLEMENTATION OF FIRWITH LOW PASS/HIGH PASS
FILTER USING ANY THREE WINDOWINGTECHNIQUES. PLOT ITS
MAGNITUDE AND PHASE RESPONSES.

PROGRAM :
// L138 fir intr.c
#include "L138 LCDK aic3106 init.h"
#define N 5
float h[N] = {
2.0000E-001,2.0000E-001,2.0000E-001,2.0000E-001,2.0000E-001
};float x[N]; // filter delay line
interrupt void interruptd (void)
{
short i;
float yn = 0.0;
x[0] = (float) (input left sample()); // input from ADC
for (i=0 ; 1i<N ; i++) // compute filter output

yn += hli]*x[1];

for (i=(N-1) ; 1i>0 ; i--) // shift delay line
x[1] = x[1-1];

output left sample((uintl6 t) (yn)); // output to DAC

return;

}

int main (void)

{ 1138 initialise intr(FS_8000 HZ,ADC_GAIN 0DB,DAC ATTEN ODB,LCDK LINE INPUT);

while (1) ;
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RESULT :

High Pass FIR filter(Fc= 800Hz).

Magnitude in Decibels

Frequncy response of High pass FIR filters (Fc=800Hz)

Low Pass FIR filter (Fc=1000Hz)
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ADDITIONAL PROGRAM

6) Design of FIR filter using windowing technique and verify the frequency response
of the filter

Program:

#include<stdio.h>

#include<math.h>

#define pi 3.1415

int n,N,c;

float wr[64],wt[64];

void main()

{ printf("\n enter no. of samples,N=":"); scanf("%d",&N);
printf("\n enter choice of window function\n 1.rect \n 2. triang \n c=:"); scanf("%d",&c);
printf("\n elements of window function are:");
switch(c)

{

case 1:

for(n=0;n<=N-1;n++)

{

wr[n]=1;

printf(" \n wr[%d]=%f",n,wr[n]);

}

break;

case 2:

for(n=0;n<=N-1;n++)

{

wt[n]=1-(2*(float)n/(N-1));

printf("\n wt[%d]=%f",n,wt[n]);

}

break; }}
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